Published 2020

This material has been developed as a prototype for implementation of the revised Lower Secondary Curriculum and as a support for other textbook development interests.

This document is restricted from being reproduced for any commercial gains.

National Curriculum Development Centre
P.O. Box 7002,
Kampala- Uganda
www.ncdc.co.ug
Contents

Preface ........................................................................................................................................................................... iv
Acknowledgements ......................................................................................................................................................... v
Chapter 1: Introduction to ICT ........................................................................................................................................ 1
  Common ICT Tools .......................................................................................................................................................... 3
  Handling and Maintaining ICT Tools ......................................................................................................................... 7
  ICT Safety Precautions ................................................................................................................................................. 8
Chapter 2: Computer Hardware and System Start up .................................................................................................. 14
  Meaning of Computer Hardware ................................................................................................................................. 15
  Assembling a Computer System ................................................................................................................................. 16
  Starting and Shutting down a Computer System ...................................................................................................... 17
  Activity 2.4: Starting and shutting down a Computer System .................................................................................. 18
Chapter 3: ICT File and Folder Management ............................................................................................................... 20
  Files and Folders ........................................................................................................................................................... 21
  Managing Files and Folders .......................................................................................................................................... 25
  The Recycle Bin ............................................................................................................................................................. 29
  Measurement of Storage Capacity ............................................................................................................................... 30
Chapter 4: Word Processing .......................................................................................................................................... 32
  Saving an MS Word document file ............................................................................................................................. 35
  Using Columns ............................................................................................................................................................... 39
  Locating Specific Text in a Word Document ................................................................................................................. 40
  Grammar and spell check .............................................................................................................................................. 41
  Character formatting .................................................................................................................................................... 42
  Changing the font ......................................................................................................................................................... 42
  Alignment of Text .......................................................................................................................................................... 44
Preface

This Teacher’s Guide has been designed to enable the teacher to interpret the revised curriculum and use the accompanying Learner’s Textbook effectively. The Teacher’s Guide provides guidance on what is required before, during and after the teaching and learning experiences.

To ease the work of the teacher, all the activities and instructions in the Learner’s Textbook have been incorporated in this Guide but with additional information and possible responses to the activities. The guide has been designed bearing in mind the major aim of the revised curriculum which is to build in the learners the key competences that are required in the 21st century while promoting values and attitudes and effective learning and acquisition of skills, to prepare the learner for higher education and eventually the world of work.

This book has been written in line with the Revised Lower Secondary School Curriculum. The book has incorporated knowledge and skills partly required to produce a learner who has the competences that are required in the 21st century; promoting values and attitudes; effective learning and acquisition of skills in order to reduce unemployment among school graduates.

Associate Professor Betty Ezati
Chairperson, NCDC Governing Council
Acknowledgements

National Curriculum Development Centre (NCDC) would like to express its appreciation to all those who worked tirelessly towards the production of the Teacher’s Guide.

Our gratitude goes to the various institutions which provided staff who worked as a panel, the Subject Specialist who initiated the work and the Production Unit at NCDC which ensured that the work produced meets the required standards. Our thanks go to Enabel which provided technical support in textbook development.

The Centre is indebted to the learners and teachers who worked with the NCDC Specialist and consultants from Cambridge Education and Curriculum Foundation to ensure the Guide meets the needs of the target group.

Last but not least, NCDC would like to acknowledge all those behind the scenes who formed part of the team that worked hard to finalise the work on this Teacher’s Guide.

NCDC takes responsibility for any shortcomings that might be identified in this publication and welcomes suggestions for effectively addressing the inadequacies. Such comments and suggestions may be communicated to NCDC through P. O. Box 7002 Kampala or email: admin@ncdc.go.ug.

Grace K. Baguma
Director, National Curriculum Development Centre
Chapter 1: Introduction to ICT

Key words
- ICT
- hardware
- software
- peripherals

By the end of this chapter, ensure that learners can:

a) explain what ICT is all about.
b) identify common ICT tools
c) describe the uses of ICTs in various fields.
d) explain the Safety precautions for the different ICT tools.

Introduction

In this chapter, the learners will learn about the meaning of ICT and appreciate its various applications in daily life. Ask them to imagine the world without ICT! How would communication, transfer of money, security, transport, learning among others in our lives be like?

Guide and observe learners as they read the introduction of this chapter in the Learner’s Book. Moderate their responses to the posed question.

Meaning of ICT

Teacher Preparation
You will need: ICT devices: camera, computer, projector, radio, etc

Time: 6 periods

Teacher Instruction
Guide learners and assess their level of understanding of items in Figure 1.1. Demonstrate ICT and water systems to demystify the comparison of the two.

ICT stands for:

I – Information

C – Communication

T - Technology

Hardly a day passes when ICT does not intrude into our lives. ICTs are used daily and in one way or another, people are connected through telephone networks, the Internet and the World Wide Web. Refer to Figure 1.1.
Imagine Mr. Kaboyo making a telephone call to his mother Mukade Jalia to send her New Year greetings. In this case, Mr. Kaboyo and his mother are communicating using a technology (mobile telephone) and Information is the New Year greeting.

ICT can be compared with other systems. Let us compare ICT and a water system.

**NOTE:** ICT is electronic while a water system is mechanical.

Imagine a water system comprising a water tank, water, taps, pipes and water moving through the pipes. This can be related to ICT as follows.

**Table 1.1: Comparison of a water system and an ICT system**

<table>
<thead>
<tr>
<th>Water system component</th>
<th>ICT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taps, water tank, pipes</td>
<td>Technology</td>
</tr>
<tr>
<td>Water</td>
<td>Information</td>
</tr>
<tr>
<td>Water flowing through pipes</td>
<td>Communication</td>
</tr>
</tbody>
</table>

**Activity 1.1: Meaning of ICT**

Guide learners in groups to move around the school or in their communities to identify ICTs familiar to them. Later in the Learner’s Book, guide their discussions as they present their findings in **Table 1.2 matching**.

- In groups, look around your school or your community and identify at least 3 ICTs familiar to you. State the function of each of the ICTs identified in the table below.
Table 1.2: ICT tools and their functions

<table>
<thead>
<tr>
<th>ICT Tool</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>E.g. Camera</td>
<td>Capturing photographs</td>
</tr>
<tr>
<td>1. Projector</td>
<td>Making projections for big audiences</td>
</tr>
<tr>
<td>2. Mobile phone</td>
<td>Making calls, chatting,</td>
</tr>
<tr>
<td>3. Laptop</td>
<td>Typing documents</td>
</tr>
</tbody>
</table>

- Select any two ICTs from Figure 1.1 and identify the information they handle, the nature of communication that takes place and the technology used.

  Projector: I-pictures, slides, documents. C – connection between computer and projector; can be wired or wireless. T – lens, projector type and its specifications

- With the available ICT tool, identify the I, C, and T in it.

  Practise using the selected ICT tool.

Common ICT Tools

Teacher Preparation
You will need: ICT devices: camera, computer, projector, radio, mobile phone
Time: 6 periods

Teacher Instruction
Guide and observe learners as they read the introduction of this section in the Learner’s Book and assess their understanding of Figures 1.2 to 1.5.

At the beginning of this chapter, the meaning of ICT was introduced. When we talk about ICT tools, we are referring to devices or objects used in ICT. As people need and use hammers, hoes, conveyor belts and pangas to produce and process and manufacture food, they similarly use tools for data capture and processing, information storage and communication.

Therefore, ICT tools are not one solid thing but rather a collection of several electronic tools.

Figures 1.2 to 1.5 show some examples of basic ICT tools we interact with in our day-to-day activities.
Activity 1.2: Common ICT tools

**Teacher Preparation**
You will need: ICT devices: camera, computer, projector, radio, mobile phone, etc

**Teacher Instruction**
Guide and observe learners as they discuss the characteristics of various ICT devices shown in Figures 1.2, 1.3, 1.4 and 1.5.

In groups, identify the ICT tool provided by name and characteristic(s). Summarise your findings in Table 1.3.

**Table 1.3: ICT Tools and their characteristics**

<table>
<thead>
<tr>
<th>Name of ICT tool/s</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>• Electronic tool</td>
</tr>
<tr>
<td></td>
<td>• Has hardware and software</td>
</tr>
<tr>
<td></td>
<td>• Can store information temporarily or permanently</td>
</tr>
<tr>
<td>Projector</td>
<td>• Electronic tool</td>
</tr>
<tr>
<td></td>
<td>• Uses light for projection</td>
</tr>
<tr>
<td></td>
<td>• Has adjustments for image sharpness</td>
</tr>
<tr>
<td>Camera</td>
<td>• Has a lens</td>
</tr>
<tr>
<td></td>
<td>• Flash light</td>
</tr>
<tr>
<td></td>
<td>• Has memory; inbuilt and external</td>
</tr>
</tbody>
</table>
Activity 1.3: Identifying ICT tools with their specialized professional fields or areas

Identify and state some ICT tools and what they can be used for in specialized fields such as communication, manufacturing, teaching and learning, health and medicine, security, climate and weather management.

Guide learners in a brainstorming session of the task. Some of the answers may include X-ray machines, biometric thumb recognition machines, ATMs, photocopiers, security cameras.

Use of ICTs in my society/Application of ICT

Teacher Preparation
You will need: Cases of real life examples where ICTs are used in our communities to provide services and share them with the learners.

Time: 6 periods

Teacher Instruction
Guide and observe learners discuss the applications of ICTs in various areas.

At the beginning of this chapter, you learnt that ICTs are used to collect and share information. In all situations, the ICT devices are used by people or programmed by people to work without people managing them.

In our society today, use of ICT is on the increase in all areas. ICTs are used to collect and communicate information in our homes, schools, hospitals, banking halls and many other places. ICTs are also used in the entertainment industry, security, agriculture and transport.

In the security sector, ICTs are used to monitor sensitive areas like banking halls, airports, screening bags for unwanted materials and objects and many others. However, good ICTs may in some cases pose challenges.

Let learners form groups in preparation for this activity.

Activity 1.4: Application of ICTs

a) While in groups, learners identify the ICT devices used in each of the application areas shown in Table 1.4 and what they are used for. Note that an application area can have as many ICT devices as possible. Table 1.4 has some of the responses.
Table 1.4: Application of ICTs

<table>
<thead>
<tr>
<th>Application area</th>
<th>Name of ICT Device</th>
<th>What is it used for?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Mobile phone</td>
<td>Sharing information in form of SMS, pictures, emails, voice messages between users.</td>
</tr>
<tr>
<td></td>
<td>Digital camera</td>
<td>Recording intruders</td>
</tr>
<tr>
<td>School</td>
<td>Digital camera</td>
<td>Recording intruders</td>
</tr>
<tr>
<td></td>
<td>Computer with report card system</td>
<td>Generating reports per term and other student details</td>
</tr>
<tr>
<td>Entertainment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Security</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hospitals</td>
<td>Computer with medical records system</td>
<td>Keeping patient records in electronic format</td>
</tr>
<tr>
<td>Transport</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agriculture</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Learners give any advantages and disadvantages of using ICTs in their society.

**Expected responses:** The learners are free to give as many responses beyond what is given in this box.

- Ease communication; fast and convenient
- Cost effective to process data/communicate
- Bridge cultural/geographical gaps; make the world a global village

Before reading the extract below, if possible, take learners to visit a supermarket which uses ICT (or any other accessible ICT facility). Let them watch and ask questions about the ICTs used and the benefits of using the ICTs.

**ICTs in Business**

Most supermarkets, especially the big ones, have adopted the use of Electronic Point of Sales (EPOS). If you have bought an item from a shop and it was scanned to determine the amount you need to pay, you have used an EPOS. An Electronic Point of Sales (EPOS) is a self-contained, computerized equipment that performs all tasks of a store checkout counter. It allows payments by cash, bank or credit cards, verifies transactions and generates a sales receipt. It also coordinates inventory data. With this technology, the shop owners are able to know the items that are bought most, what is left in the stores and the items that are running out.
With learners discuss the extract above and explain any unknown terms.

**Activity 1.5: Application of ICT in business**

a) Guide learners in groups to identify the ICT devices used in any business in their area and what they are used for. Let the learners present their findings to the rest of the class.

Guide learners in identifying a business and the ICT devices used there. Possible answers: Mobile phone calculator to compute totals, etc

b) Let learners discuss and make presentations on the different ways in which a mobile phone can be used as an ICT tool to support business activities. Validate their answers.

Ask learners their opinion about why they think it is important to maintain ICTs tools before reading the extract below.

**Handling and Maintaining ICT Tools**

Taking care of your ICT tools is just as important as taking care of your books. The internal and the external parts of the computer and other ICTs have to be cared for. Taking care of ICT tools is supposed to be done by all people who use these ICT tools. However, as a learner you cannot do all care and safety activities. Activities that require one to open up these tools are left to people who have undergone specialized training on how to do it. As a user and student of ICT, there are certain tasks you can perform to ensure your ICT tools are clean and here are a few:

- **Keep dust away:** Dust your computer to keep it free of dust and dirt.
- **Keep food away:** Do not eat or drink while working on the computer.
- **Use clean and dry hands:** Make sure your hands are clean before you type on the keyboard or click the mouse.
- **Treat with respect:** If you are having problems with your computer, ask for help. Do not bang or hit the computer.
- **Keep off:** Seeing that when the computer is connected to electricity, means that lightning could be conducted to your computer through the electrical connection. For this reason it is best not to use your computer during a storm.
- **Stop virus attack:** A computer virus is a program written by a person on purpose to harm other peoples’ computers. A computer virus is passed from one computer to another when you share and download files without the protection of antivirus software. For this reason you should get permission before downloading files.
- **Handle with care:** The way you handle your CDs will determine how long they will last. Always hold the CD correctly as shown in the picture.
Teacher Preparation
You will need: Tools used in ICT maintenance operations, blower

Teacher Instruction
Guide and observe learners demonstrate the handling and maintaining of various ICT tools. For instance they can use a blower to blow dust out of a computer.

Guide learners in a brainstorm on the functions of the maintenance tools given in Table 1.5.

Some computer laboratory safety and maintenance tools and their functions are summarized in the table below.

Table 1.5: Maintenance tools and their functions

<table>
<thead>
<tr>
<th>Maintenance tool</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dust blower</td>
<td>• Can be regularly used to blow dust out of computer equipment.</td>
</tr>
<tr>
<td>Air conditioner</td>
<td>• Regulates computer lab temperatures.</td>
</tr>
</tbody>
</table>

Activity 1.6: Handling and Maintaining ICT Tools

i) Other than a dust blower and an air conditioner, ask learners to identify any other ICT maintenance tools in the computer laboratory and state their functions.

ii) Let learners identify a computer which needs cleaning and clean it up with the necessary tools.

iii) Ask learners to make a report of the steps followed and tools used in the cleaning process in (ii) above.

ICT Safety Precautions

Time: 6 periods

Guide learners to make a visit to the computer laboratory and identify the Dos and Don’ts in a computer laboratory.

Inform learners that as ICT users, it is very important to take precautions when using ICT tools to avoid getting health problems. They will learn more about this in the chapter on Health and Safety. Inform learners that to ensure that ICT tools are properly used with caution, manufacturers provide user manuals for all ICT equipment.

Activity 1.7: ICT Safety precautions

Ask learners in groups, to discuss the “rules that govern the use of the computer laboratory”.

Find out from learners why it is important to protect ICT tools.
ICT Tools Security Threats and Measures

Ask learners to read the text in their textbook. ICT tools like any other tools need protection because they can be exposed to a number of risks such as theft, virus, vandalism and others. However, care must be taken in terms of handling, when they are in use and after use to protect them and make them less expensive to maintain. Physical security, electronic security and document/files and network security are very critical in addressing the measures of protecting and caring for ICT tools. Some examples of these security measures include burglar proofing for physical security, use of passwords for electronic security and use of firewalls for network security.

Activity 1.8: ICT tools security threats and measures

i) Take the learners for a walk around the school computer installations and let them identify some security and safety concerns.

ii) Let learners identify how computers need to be protected in order to be used for a long period of time. In groups, discuss security and safety measures to safeguard these computers in line with physical security, electronic security and document/files and network security.

User Manuals

Teacher Preparation
You will need: Photocopies of a sample user manual of any available ICT tool/device, projector, camera, and laptop/computer. You may ask learners if possible, to come with samples of the manuals of any ICT tool/device.

Teacher Instruction
Guide as they discuss all sections of the user manual.

Ask learners in groups to study and identify the features in a user manual before reading the extract below in their textbook.

A user guide or user’s guide, also commonly known as a manual, is a technical communication document intended to give assistance to people using a particular system. A user guide (see image below) contains instructions on installing, using, or troubleshooting a hardware or software product.
Activity 1.9: ICT user manuals

i) After studying the user manual provided for a given ICT tool, let them summarize its contents and present safety precautions therein.

Guide learners to make convenient groups, study the manual provided, prepare and make a presentation to the class.
Activity of Integration

ICTs are currently being employed in almost all fields in this modern era. Some of these fields are Education, Banking and Security. In the area of education, it is possible for a teacher in London to virtually conduct a lesson in a school in Uganda.

Tasks

a) Explain how the lesson above can be conducted with ICTs.

b) Explain the precautions that should be exercised when using the ICT tools in (a) above.

Evaluation Grid with Suggested Responses

<table>
<thead>
<tr>
<th>Output</th>
<th>Basis of evaluation</th>
<th>Criteria 1: Relevance</th>
<th>Criteria 2: Accuracy</th>
<th>Criteria 3: Coherence</th>
<th>Criteria 4: Excellence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation of how ICTs can be used to deliver a lesson</td>
<td>Use of ICTs</td>
<td>Score 3 if the learner identifies at least 5 appropriate ICT tools/services used to deliver the lesson. These include: camera, computer, Internet, projector, microphone, speakers and smart board.</td>
<td>Score 3 if the learner explains the clear purpose for each of the identified ICT tools/services used to deliver the lesson (at least 5).</td>
<td>Score 3 if the learner ensures logical flow and clarity of the sequence in which the identified ICT tools/services are used to deliver the lesson (for at least 5 ICT tools).</td>
<td>Score 1 if the learner has added any exceptional response unsolicited in the instructions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Score 2 if the learner identifies at least 3-4 appropriate ICT tools/services used to deliver the lesson. These include: camera, computer, Internet, projector, microphone, speakers, smart board.</td>
<td>Score 2 if the learner explains the clear purpose for each of the identified ICT tools/services used to deliver the lesson. (3-4)</td>
<td>Score 2 if the learner ensures logical flow and clarity of the sequence in which the identified ICT tools/services are used to deliver the lesson (for 3-4 ICT tools).</td>
<td></td>
</tr>
<tr>
<td>Output</td>
<td>Criteria 1</td>
<td>Criteria 2</td>
<td>Criteria 3</td>
<td>Criteria 4</td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Basis of evaluation</td>
<td>Relevance</td>
<td>Accuracy</td>
<td>Coherence</td>
<td>Excellence</td>
</tr>
<tr>
<td></td>
<td>Score 1 if the learner identifies at least 5 appropriate ICT tools/services used to deliver the lesson. These include: camera, computer, Internet, projector, microphone, speakers, smart board</td>
<td>Score 1 if the learner explains the clear purpose for each of the identified ICT tools/services used to deliver the lesson. (1-2)</td>
<td>Score 1 if the learner ensures logical flow and clarity of the sequence in which the identified ICT tools/services are used to deliver the lesson.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Precautions required</td>
<td>Care for ICTs selected above</td>
<td>Score 3 if the learner identifies at least 5 precautions for the selected ICT tools/services used to deliver the lesson.</td>
<td>Score 3 if the learner explains how the precaution is realized for each of the identified ICT tools/services (at least 5).</td>
<td>Score 3 if the learner ensures logical flow and clarity of the sequence in which the identified precautions are used (at least 5).</td>
</tr>
<tr>
<td></td>
<td>Score 2 if the learner identifies at 3-4 precautions for the selected ICT tools/services used to deliver the lesson.</td>
<td>Score 2 if the learner explains how the precaution is realized for each of the identified ICT tools/services. (3-4)</td>
<td>Score 2 if the learner ensures logical flow and clarity of the sequence in which the identified precautions are used (3-4).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Score 1 if the learner identifies at 1-2 precautions for the selected ICT tools/services used to deliver the lesson.</td>
<td>Score 1 if the learner explains how the precaution is realized for each of the identified ICT tools/services (1-2).</td>
<td>Score 1 if the learner ensures logical flow and clarity of the sequence in which the identified precautions are used (1-2).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*2/3 of the score for all outputs are sufficient to conclude that a learner is competent.*
Chapter Summary

Ensure that learners have learnt about:

- the meaning of ICT.
- common ICTs at workplaces and their uses.
- application of ICTs in our daily lives.
- handling and maintaining of ICT tools.
- ICT safety precautions and security threats.
Chapter 2: Computer Hardware and System Start up

Key

By the end of this chapter, the learner should be able to:

a) know the physical devices of a computer system and how each operates.
b) assemble a computer system.
c) safely start and shut down a computer system.
d) use computer peripheral tools.

Introduction

In this chapter you will learn about the physical parts of the computer and their use in everyday life. Different parts of a computer are assembled to make a complete system. These parts may be manufactured by the same company or different companies. Some of the hardware parts are internal components (within the system case) while others are peripherals (externally connected to the system case through a port). As a computer user, you should know how to assemble the hardware parts and safely start the computer.
Meaning of Computer Hardware

Have you ever used a desktop computer? You realise that there is not any single part called a Computer. Generally, a computer is a system of many parts working together as shown in Figure 2.1.

![Figure 2.1: Computer Hardware](image)

The **tangible** parts that you can touch and feel such as the monitor, keyboard, mouse, disk drives, printer, scanner and speakers, are collectively referred to as **hardware**. The opposite of hardware is **software**, which refers to the instructions or programs that tell the hardware what to do. Software is intangible.

**Note:** In comparison with the human being, hardware may be considered as the body while software is the brain.

Imagine you have been asked to type and produce a letter inviting your head teacher a debating competition in your class on Tuesday at 2:00pm in the main hall. In this case, you can use a keyboard for typing, a mouse for controlling the cursor on the screen (these are input devices), the printer will be used to produce a hard copy of the work seen on the screen (output). Storage is done within the system unit where a hard disk is the one responsible for this activity.

**Activity 2.1: Parts of a computer**

1. Discuss and identify whether use of each of the devices labelled in Figure 2.1 is an input, output, storage, communication or processing device and summarize your findings in the table below:

<table>
<thead>
<tr>
<th>Label</th>
<th>Name of device</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>mouse</td>
<td>input</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Categories of Computer Hardware

Hardware devices are categorized according to their functions. The various hardware categories include input, output, storage, communication and processing devices. Input devices are used for entering data or information into the computer after which other processes can follow. Output hardware is used for producing or displaying information which can be in form of a soft copy or hard copy. Storage devices are used for storing data or information for future use. The storage devices can be inside the computer itself (internal) or can be external to the computer. Sometimes storage devices can be looked at in terms of the methods used to store data on them. For example, can you compare a flash disk and a CD? The method of storing data on each of these devices is different.

Activity 2.2: Categories of Computer hardware

1. What is the difference between a soft copy and a hard copy? Give examples to support you answer.
2. Move around the computer laboratory or any office in your school and identify other computer hardware devices other than those mentioned in 1) above. Summarize their details in terms of Name, features, function and category.
3. Identify at least one device in each category and demonstrate how it works.

Assembling a Computer System

At the beginning of this chapter, you looked at hardware devices which can be categorized as input devices like mouse, keyboard, microphone, camera; Output devices like monitor, printer, projector, speakers; Storage devices like hard disks, flash disks compact disks; processing devices like a CPU. Some of these devices are summarized in Figure 2.2.

Figure 2.2: Some examples of computer hardware

When these devices are connected together, they make a computer system. For a computer system to work well, the above hardware devices must be connected properly. For instance, a keyboard, mouse, monitor should be connected to the System...
unit, the system unit and monitor then connected to power directly to the sockets or through a UPS by use of power cables.

If you are setting up a newly purchased computer, you will probably find a how-to use or a user guide in the packaging that includes step-by-step details. However, even if it does not include instructions, you can still set up the computer in just a few easy steps.

Activity 2.3: Assembling a Computer System (Desktop)

1. With guidance from your teacher, assemble a computer system from its various parts provided in the computer laboratory. You can make reference to the guidelines below.

   **Step 1:** Check whether all the devices required are available.
   **Step 2:** Locate the monitor cable. It will usually be either a VGA or DVI cable. VGA cables will often have blue connectors to make them easier to identify.
   **Step 3:** Connect one end of the cable to the monitor port on the back of the computer case and the other end to the monitor. Hand-tighten the plastic-covered screws on the monitor cable to secure it.
   **Step 4:** Connect other devices by critically looking at the port types.
   **Step 5:** Locate the power supply cables. Plug the first power supply cable into the back of the computer case, and then into a surge protector. Then, using the other cable, connect the monitor to the surge protector.
   **Step 6:** Finally, plug the surge protector into a wall outlet. You may also need to turn the surge protector on if it has a power switch.

   **Note:** If you do not have a surge protector, you can plug the computer directly into the wall. However, this is not recommended, as electrical surges can damage your computer.

2. Explain any key steps followed to assemble a computer system in 1. above.
3. What precautions must be taken while assembling a computer system?

**Setting up a laptop computer**

If you have a laptop, setup should be very easy. Just open it up and press the power button. If the battery is not charged, you will need to plug in the AC adapter and charge it before using it.

If your laptop has any peripherals, such as external speakers, you may want to read the instructions below, since laptops and desktops generally use the same types of connections.

**Starting and Shutting down a Computer System**

After assembling a computer (see Figure 2.3), the next step is how it can be powered on correctly, used and then shut down with proper procedures. The process of starting a computer is called booting.
Starting the computer

- Make sure all the plugs are well connected.
- Switch on the electricity socket and the Uninterruptible Power Supply Unit.
- Press the power button on the computer monitor first. It should show signal.
- Press the power button on the system unit.
- The computer should now start to boot and load windows.
- If the welcome screen appears, select your username and enter the password.
- The Desktop should now appear.
- Give it time to load the elements and start up programs.

Shutting down a Computer System

Turn Off Computer option is located on the Start menu. The Turn Off Computer dialog has the Turn off the computer, Standby/Hibernate, and Restart Option. Log Off and Switch User options are also located on the Start menu.

Activity 2.4: Starting and shutting down a Computer System

1. Explain the logical order of switching on the assembled computer system and how it can be shut down properly.
2. Stating from a fully connected compute system, demonstrate how a compute can be switched on and later switched off after use.
3. What precautions MUST be considered in 2) above.

Activity of Integration

Chapter Summary

In this chapter, you have learnt about:

a) the physical devices of a computer system and how each operates.
b) how to assemble a computer system.
c) safely starting and shutting down a computer system.
d) using computer peripheral tools.
Chapter 3: ICT File and Folder Management

Key Words
- file
- folder

By the end of this chapter, ensure that the learners can:
  a) use the different types of storage media to create, save and transfer files.
  b) convert data storage into various units.

Introduction
Hard disk drives have become very large in recent years and are capable of holding millions of data files created by computer applications installed on the computer. As a result, a method of organising these files is essential. Windows uses folders to achieve this.

File management is about arranging your work on a computer in a way that makes it accessible and easy to use. While working with your computer programs, you create and save files, such as letters, drawings, or budgets in an organized way. You use folders to group related files, as with paper folders in a file cabinet. In this chapter you will be able to use different types of storage media to store information following the structure of files, folders and directories.

Guide and observe learners as they read the introduction of this chapter in the learner’s textbook. Moderate their discussions if any.
Files and Folders

**Teacher Preparation**
You will need: A Computer with various files and folders in the same location.

**Teacher Instruction**
Guide learners and assess their level of understanding of files and folders. Demonstrate how to create files and folders to simplify the distinction between the two.

Files can be stored in folders. Folders can be stored within other folders and these are referred to as sub-folders. Examples of the appearances of a file and a folder in Windows Operating System is shown below.

![File and Folder Examples](image)

File names are made up of two parts; document name and file extension.

The document name can be up to 256 characters long, including spaces while the file extension is determined by the application being used. Some examples of file extensions are shown in the table below.

<table>
<thead>
<tr>
<th>Application</th>
<th>File extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Word</td>
<td>.doc / .docx</td>
</tr>
<tr>
<td>Microsoft PowerPoint</td>
<td>.ppt / .pptx</td>
</tr>
</tbody>
</table>

Files and folders can be stored on various storage media such as flash discs and hard discs.

**Activity 3.1: File extensions and storage media**

Guide learners in groups to move around the school offices or computer lab to identify various storage media. While identifying file extensions, provide access to computers where learners can make discoveries from. Guide learners’ discussions as they present their findings.

1. Other than Hard discs and flash discs, identify other three different storage media within your school computer lab.
   - CDs, DVDs, Memory cards, Internet (Email/Social media accounts), Floppy discs

2. Compare any two storage media in terms of their advantages and disadvantages.
Comparison in terms of size, cost, convenience (ease of access), and technology used to save on it (ease of use).

3. What are the file extensions of files created with:
   - Microsoft Office Access
   - Microsoft Office Publisher

| Microsoft Office Access - .mdb |
| Microsoft Office Publisher - .pub |

**Organising Files**

Guide and observe learners as they read the text in the Learner’s Book. Moderate their discussions if any. Guide learners through the example given by the way of demonstration.

The management of computer files and paper files has much in common. If all the paper documents accrued in a house or business were stored in a single drawer without using paper folders, it would soon become impossible to find anything.

A well organised house will have some filing system to segregate electric bills from telephone bills and from bank statements etc. Files on a computer should be managed in a similar manner.

A good practice is to use a **Personal Folder** to organise your files. This is the equivalent of a filing cabinet in paper filing. It can be created in the **My Documents** folder or in the **C: Drive** of the computer. This folder is the **Root Folder** of the filing system. Subfolders can then be created for subject areas. Within these, further subfolders can be used to organise the files within each subject. An example is shown below:

- **Create a root folder in My Documents**

- **Create sub-folders** within the root folder for subject areas etc.
• Create further sub-folders within the subject area folders.

• Continue the process until the required level of organisation is achieved.

This organisation will make files easier to find and **backing up** your files will involve copying the **root folder** to the backup device.

**Activity 3.2: Creating folders**

In groups, guide learners through this activity by the way of demonstration. Learners should try at least 1 method. Allow learners to try out other methods as much as possible depending on the availability of computers and time.

Folders can be created by a number of methods:

**Method 1:**

1. Browse to where you want to create the folder.
2. Click the File menu, choose New and then Folder.
3. The folder is created.

4. Type a name for the folder and press **Return** or click away from the folder to complete.

![My Documents window with New and Folder options]

**Method 2:**

5. Browse to where you want to create the folder.

6. **Right-click** within the window, choose **New** and then **Folder**.

![My Documents window with options to create a new folder]

7. Complete as for method 1.

**Method 3:**

A folder can be created while saving a file in a computer application.

1. In **Word 2007**, click the **Office button** and choose **Save As** and **Word Document**.

![Office button and Save As option]
2. Browse to the required folder and click the Create New Folder button.

3. Name the folder and Double-click it to open it. Save the file in the new folder.

Managing Files and Folders

Files and folders can be selected, copied, pasted, moved, renamed and deleted.

Activity 3.3: Selecting Files

In groups, guide learners through this activity by the way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

1. Open a drive or go to desktop where there are files and folders.
2. To select a single file, just click it. It changes colour on selection.
3. To select consecutive files, click the first file, hold down the Shift key and select the last file. The files in between are automatically selected.
4. To select non-consecutive files, hold down the Alt key and select the files in turn.

5. To select all the files in a folder, click the Edit command and choose Select All.

**Note:** The above procedures apply equally to groups of folders.

**Activity 2.4: Copying and pasting files**

In groups, guide learners through this activity by the way of demonstration. Allow learners to demonstrate other methods which may not be specified in the learner’s book provided they achieve the desired results.
1. First **select** the required file/s. Then **right-click** the files and choose **Copy**. The files are copied in an area of memory called the **Clipboard**.

![ Clipboard Image ]

2. Browse to the **destination folder**, **right-click** it and choose **Paste**.

![ Paste Image ]

**Moving Files**

The procedure is similar to **copy and paste** except that instead of choosing **Copy**, you choose **Cut**.

![ Cut Image ]
**Rename Files**

Files must be renamed individually. To rename a file, right-click it and choose Rename. Type the new name and press Return or click away from the file.

**Deleting Files**

Select the files to be deleted. Right-click any selected file and choose delete from the menu. Click the Yes button in the dialog box.
**The Recycle Bin**

Files and folders deleted from the computer are placed in the recycle bin. They are not lost until the recycle bin is emptied.

**Activity 2.5: Managing the Recycle Bin**

1. Delete a folder normally by **right-clicking** the folder and selecting **Delete**.

2. Check in the Recycle Bin to confirm if the folder/file has arrived.

3. To **Undelete** the folder, **right-click** the recycle bin and choose **Open**.

4. From the **Edit menu**, choose **Undo Delete** to restore the folder to its original location as it gets out of the recycle bin.
Measurement of Storage Capacity

Teacher Preparation
You will need: A Computer with various files and folders with varying sizes

Teacher Instruction
Guide learners to check the sizes of various files both small and large and discuss the differences.

In a computer system, data is represented using the binary system; combinations of binary digits (bits). There are only two binary digits, 1 and 0. These digits can be arranged in such a way that they represent characters, digits and other values.

Data storage has various units including bits (b), Bytes (B), Kilobytes (KB), Megabytes (MB), Gigabytes (GB), and Terabytes (TB).

Activity 3.4: Data storage units
In groups, guide learners through this activity by the way of demonstration. Allow learners convert file sizes from one unit to another. Distinguish between a bit and a byte.

Bits and bytes both measure amounts of data. However, they are typically used in two different contexts. Bits, kilobits (Kbps), and megabits (Mbps) are most often used to measure data transfer speeds. The other important difference is that bytes contain eight bits of data.

1. What is the relationship between bits, bytes, kilobytes, megabytes, gigabytes and terabytes? Give examples where necessary.

Bits are usually assembled into a group of eight to form a byte.

A kilobyte (KB) is 1,024 bytes, not one thousand bytes as might be expected, because computers use binary (base two) math, instead of a decimal (base ten) system.

Computer storage and memory is often measured in megabytes (MB) and gigabytes (GB). A medium-sized novel contains about 1 MB of information. 1 MB is 1,024 kilobytes, or 1,048,576 (1024x1024) bytes, not one million bytes.

Similarly, 1 GB is 1,024 MB, or 1,073,741,824 (1024x1024x1024) bytes. A terabyte (TB) is 1,024 GB; 1 TB is about the same amount of information as all of the books in a large library, or roughly 1,610 CDs worth of data. A petabyte (PB) is 1.024 TB.

1 PB of data, if written on DVDs, would create roughly 223,100 DVDs, i.e., a stack about 878 feet tall, or a stack of CDs a mile high.

Many hard drive manufacturers use a decimal number system to define amounts of storage space. As a result, 1 MB is defined as one million bytes, 1 GB is defined as one billion bytes, and so on. Since your computer uses a binary system as
Activity of Integration

1. A researcher saved her draft work on a CD ROM from a friend’s computer with an intention of sending it to her supervisor by e-mail once she got home. However, on reaching home, she realized that her computer could not read a CD ROM.

   **Task:** How can you advise this researcher to have her work sent to the supervisor without physically going back to her friend?

2. A student borrowed a computer with a hard disk of 40GB on which he saved his project work for 3 years. The project work on the hard disk is stored on a space of 30GB. Recently, the owner of the computer requested to have it back and provided the student with a pack of 100 CDs each with a storage capacity of 700MB on which project data can be transferred.

   **Task**
   
   a) Describe how the project data could be transferred from the hard disk onto the CDs provided by the student.
   b) How many CDs full of data do you think the student used? Give reasons for your answer.

   **Rounded downwards because the other CD will not be full.**

Chapter Summary

In this chapter, you have learnt about:

- creating, saving and transferring files across various media.
- converting data storage into various units.
Chapter 4: Word Processing

Key words
- word processing
- layout
- mail merge

By the end of this chapter, ensure that the learner should be able:

a) use the word processor interface.
b) use a word processing software to create, format, edit and print a document.

Introduction

Word processing is a very important skill for you if you are aiming at becoming computer literate. Once you have learnt word processing; you will be in position to use a word processing software (e.g. MS Word) appropriately to create, edit and print documents.

There are specialized programs which you can use in word processing. Such programs are called word processors. A word processor has numerous features whose uses you need to understand if you are to use it appropriately.

Microsoft Office Word is one of the most commonly used word processing software. Different versions of Microsoft Office Word include MS Word 2007, 2010, 2013, 2016 etc. In this book we are going to demonstrate using Microsoft Office Word 2007/2010 platforms.
Guide and observe learners as they read the introduction of this chapter in the Learner’s Book. Moderate their discussions if any.

**Features of a Word Processor**

**Teacher Preparation**
You will need: A Computer with a word processing application.

**Teacher Instruction**
Guide learners as they go through the features of a word processor. Demonstrate how to arrive at the word processor window.

The image on the right shows a window of a word processor with some features that enable a user to manipulate a document.

**Activity 4.1: Understanding the features of a word processor**

In groups, guide learners through this activity by the way of demonstration. Allow learners to demonstrate other methods which may not be specified in the learner’s book provided they achieve the desired results.

In groups:

1. open a word processor.
2. identify the groups of the word processing features.
3. type the sentence “I love my school”.
4. select (highlight) the sentence in 3 above and click on any three features.
5. observe the changes which occur in the text.
6. state the function of each of the features identified.
Copy and complete the table shown below about the features of a word processor

<table>
<thead>
<tr>
<th>Feature identified</th>
<th>Group it belongs to</th>
<th>Use of the feature in word processing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

7. Share your findings on the word processing features and the group they belong to.

Hint: To open a word processor, go to Start → All Programs → MS Office → Word Processing program

Customizing Word Processing Working Environment

Before you begin creating documents, ensure that you have set up your Word environment and become familiar with a few key tasks such as minimizing and maximizing the Ribbon, configuring the Quick Access toolbar, using the ruler, word counting and zooming tools.

Activity 4.2: Setting a word processing environment

In groups, guide learners through this activity by the way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

Customizing the Quick Access Toolbar

1. Click the arrow to the right of the Quick Access toolbar.
2. Select the command you want to add from the drop-down list. It will appear in the Quick Access toolbar.
Minimising and Maximising the Ribbon

3. Right-click anywhere in the main menu.

4. Select **Minimize the Ribbon** in the menu that appears. This will toggle the Ribbon on and off.

**Customising the Quick Access Toolbar**

1. Click the arrow to the right of the Quick Access toolbar.
2. Select the command you want to add from the drop-down list. It will appear in the Quick Access toolbar.

**Minimising and Maximising the Ribbon**

3. Right-click anywhere in the main menu.

4. Select **Minimize the Ribbon** in the menu that appears. This will toggle the Ribbon on and off.

**Customising the task bar**

5. Right click anywhere on the task bar.
6. Select the items you would like to appear on your task bar as you work from the popup menu.

**Saving an MS Word document file**

Saving is a process of storing a document in a certain location or creating a file. This can be done on a newly created document or on an already existing document. Saving is normally in two categories; **Save** and **Save As**.

When saving for the very first time, **Save** and **Save As** behave the same way. They both prompt for file name and location.

Click on the Office button>Save As>Type File Name>Choose Location>Save

Otherwise, **Save** and **Save As** behave differently on an existing document.

**Activity 4.3: Saving a file**

Guide learners through this activity by way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.
Saving a document with file name NCDC in My Documents location:

1. Open MS Word program.
2. Select **Office Button > Save** or **Save As**.
3. Select **Desktop** as the location to save in.
4. Give the file a name, **NCDC**.

**Tip:** Save your file immediately after creating it to prevent the possibility of losing it later due to power failure.

**Activity 4.4: Working with text**

In groups, guide learners through this activity by the way of demonstration. Allow learners to demonstrate other methods which may not be specified in the learner’s book provided they achieve the desired results.

1. Type some text in your text area of about four paragraphs to help you practise word processing skills. Press **Enter** key on your keyboard to get to the next line.

**Selecting text**

2. Move your insertion point next to the text you want to select.
3. Left-click and while holding down, drag the mouse over the text you want to select.
4. Release the mouse button. You will have selected the text. A **highlighted box** will appear over the selected text.

**Inserting text anywhere in your text**

5. Move your mouse to the location where you want text to appear in the document.
6. Left-click the mouse. The **insertion point** appears.
7. Type the text you want to appear.

**Deleting text**

8. Place your cursor next to the text you want to delete.
9. Press the **Backspace** key on your keyboard to delete text to the left of the cursor.
10. Press the **Delete** key on your keyboard to delete text to the right of the cursor.
Copying and pasting text

11. Select the text you want to copy.
12. Click the Copy command on the Home tab.
13. Place the cursor where you want text to appear.
14. Click the Paste command on the Home tab.

Tip: Highlight text before applying any formatting on it.

Page layout

All along you have been using the default settings of your word processor. You are now going to learn how to change these settings to suit your document requirements. In the next set of activities you will learn how to change the margins, document orientation, use columns in your document as well as adjust the line spacing of text.

Activity 4.5: Changing page orientation

In groups, guide learners through this activity by way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

Open a page with text on it.

1. Select the Page Layout tab.
2. Click the Orientation command in the Page Setup group.
3. Left-click either Portrait or Landscape to change the page orientation.
Activity 4.6: Setting the margins

In groups, guide learners through this activity by way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

The margins of the document determine the amount of text area for your document. To change your margins:

1. Select the **Page Layout** tab.
2. Click the **Margins** command. A menu of options appears. **Normal** is selected by default.
3. Left-click the predefined margin size you want.

You can also change the page margins by clicking on the **custom margin** from the menu. The page set up dialog box appears from which you use the arrows or directly type in the desired margin sizes.
Using Columns

Most newspapers, magazines, academic journals, and newsletters layout their texts in columns. In the default settings your word processor has one column.

Activity 4.7: Using columns in text

In groups, guide learners through this activity by the way of demonstration. Allow learners to demonstrate other methods which may not be specified in the learner’s book provided they achieve the desired results.

You can change the number of columns by following these steps:
1. Create a paragraph of text or copy and paste some text onto your page.
2. Select the text you want to format.
3. Select the Page Layout tab.
4. Left-click the Columns command.
5. Select the number of columns you want to insert.

Note: More columns can be got by selecting the more Columns menu.

Navigating through a document

Navigation means moving around a document. This can be done using arrow keys shown below or keyboard shortcuts.
Activity 4.8: Using arrow keys

1. Open a word document with text.
2. Press the arrow keys on your keyboard and observe how the cursor moves around the screen. You can also click your mouse within the document to place the insertion point where you want to type next.

Locating Specific Text in a Word Document

When a document comprises many pages, locating a specific text might be cumbersome. Word processors have a mechanism of locating specific texts.

Activity 4.9: Locating specific text

In groups, guide learners through this activity by the way of demonstration. Allow learners to demonstrate other methods which may not be specified in the learners’ book provided they achieve the desired results.

1. Load a file with text on at least two pages.
2. Click the Home ribbon’s Find button to display the Find and Replace dialog box OR Press Ctrl+F to display the Find and Replace dialog box.
3. Enter Search Text.
4. Type the text you want to find in the Search for textbox.
5. Start the Search.
6. Click the Find Next button.

Note: Word searches from the current text cursor’s position in the document to the end of the file. If Word finds the text, it highlights it.

Activity 4.10: Replacing Text

In groups, guide learners through this activity by the way of demonstration. Allow learners to demonstrate other methods which may not be specified in the learner’s book provided they achieve the desired results.

1. Select the text you want to replace.
2. Click the Home ribbon’s Replace button instead of the Find button to display the Find and Replace dialog box. OR Press Ctrl+H to display the Find and Replace dialog box.
3. Type the new text into the “Replace with” text box.
4. Replace the Text.
5. Click the Replace button to replace the next occurrence of the found text with your replacement text.
**Grammar and spell check**

When you are typing, sometimes a wavy red or green line appears beneath your text. **Red** and **Green** wavy lines indicate **spelling** and **grammatical** errors respectively. Missing space after a comma or a period, or doubling of a word (the the), is also detected as a mistake. Below is an example of a spell checker in action.

When you are **typing**, sometimes a wavy red or green line appears beneath your text. **Red** and **Green** wavy lines indicate **spelling** and **grammatical** errors respectively. Note that a word processor also regards a missing space after a comma.

**Activity 4.11: Text proofreading**

In groups, guide learners through this activity by the way of demonstration. Allow learners to demonstrate other methods which may not be specified in the learner’s book provided they achieve the desired results.

1. Open a new document.
2. Mistype a word so that the wavy red line appears. For instance **typing**.
3. Right click on the underlined word. A context-sensitive menu will open up.
4. Click on the correct suggestion, the mistyped word will automatically be replaced.

In case Word does not make any suggestions, then check whether maybe you left out a space after a period or comma. Please note that there are many proper nouns and specialist terms that Word does not recognize.

**Tip:** A wavy red line does not always mean that you have made a mistake!
Character formatting

Formatting is the art of making your documents effective and attractive. Good formatting distinguishes different parts of your text and helps your readers take in your message. Word processors provide a wide range of tools that can help you create professional looking documents. Characteristics that affect the appearance of one or more characters are called character formats. You can apply formatting to just about every element of your document, from a single character to entire paragraphs. The formatting ribbon below contains functions which can format characters, sections, and paragraphs.

Changing the font

Use the Font dialog box to format characters. Letters, numbers, and punctuation marks are all printable characters and, as such, you can format them. Once you select a character or a group of characters, you can apply any of the formatting commands on the Home tab’s Font group (Alt+H). You can choose a font and a size for any character in your document. You can make characters bold, underlined, superscript, or change them to just about any colour of the rainbow.

Activity 4.12: Character formatting

In groups, guide learners through this activity by way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

1. Select the text you want to format.
2. Find the Font field on the Home ribbon.
3. Click the drop-down arrow next to the Font field.
4. A list with countless font choices appears as shown below.
Character formatting

Formatting is the art of making your documents effective and attractive. Good formatting distinguishes different parts of your text and helps your readers take in your message. Word processors provide a wide range of tools that can help you create professional looking documents. Characteristics that affect the appearance of one or more characters are called character formats. You can apply formatting to just about every element of your document, from a single character to entire paragraphs. The formatting ribbon below contains functions which can format characters, sections, and paragraphs.

Changing the font

Use the Font dialog box to format characters. Letters, numbers, and punctuation marks are all printable characters and, as such, you can format them. Once you select a character or a group of characters, you can apply any of the formatting commands on the Home tab's Font group (Alt+H). You can choose a font and a size for any character in your document. You can make characters bold, underlined, superscript, or change them to just about any colour of the rainbow.

Activity 4.12: Character formatting

In groups, guide learners through this activity by way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

1. Select the text you want to format.
2. Find the Font field on the Home ribbon.
3. Click the drop-down arrow next to the Font field.
4. A list with countless font choices appears as shown below.
5. Select the font you want by clicking its name.

You can also change the font size to your preference.

6. First select the relevant text.
7. Find the Font Size field on the Home ribbon, and click the drop-down arrow next to it.
8. On the list, find the font size that suits you and click it.

You can also format your text to be bold, italic or underlined.

Tip: You can also specify your own font size by clicking in the Font Size field and typing in the size that you want and then press ENTER.

Activity 4.13: Bolding, italicizing and underlining

In groups, guide learners through this activity by way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

1. Select the relevant portion of your text.
2. Click the appropriate character formatting button on the Home ribbon.
The drop down arrow next to the **underline** button offers you a choice of underlining styles.

3. To turn a character format off, select the text and click the same button again.

## Alignment of Text

In groups, guide learners through this activity by the way of demonstration. Allow learners to demonstrate other methods which may not be specified in the learner’s book provided they achieve the desired results.

By default, paragraphs are usually left-aligned: the left margin is straight, but the right margin is jagged. Word provides you with a number of other options though. Just position your cursor anywhere in the paragraph, and click one of the text alignment buttons on the Home ribbon.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Align left" /></td>
<td>Align left: text is aligned at the left margin but jagged on the right.</td>
</tr>
<tr>
<td><img src="image" alt="Center" /></td>
<td>Center: text is centred within each line, with jagged margins on both left and right.</td>
</tr>
<tr>
<td><img src="image" alt="Align right" /></td>
<td>Align right: Text is aligned at the right margin but jagged on the left.</td>
</tr>
<tr>
<td><img src="image" alt="Justify" /></td>
<td>Justify: text is aligned at both the left and right margins (Word does this by adjusting the amount of space between words).</td>
</tr>
</tbody>
</table>

### How to Create a Bulleted and Numbered List

#### Using bullets

- First, type the points that you want to bullet, one under another. Make sure you create them as individual paragraphs by pressing [ENTER] after typing each point.
- Select the paragraphs that you would like to bullet.
Click the **Bullets** button in the **Paragraph** section of the **Home** ribbon.

Tip: The drop-down arrow on the right of the **Bullets** button allows you to choose from different bullet styles.

### Creating a numbered list

Instead of clicking the **Bullets** button, click the **Numbering** button just next to it. The best thing about Word numbering is that the numbers adjust themselves automatically when you edit the text!

Tip: To end a bulleted or numbered list, just press [ENTER] twice.

To change the Bullet/Number Style, go to the drop down list bullet or number (figure below) and select an option.

Note: Adding a numbered list follows similar steps.

### Adjusting line spacing

When words are close together or sentences are compact, they can be difficult to read for some people. Depending on the font type used, it may not look nice to read. Therefore, word processors have line spacing provision to allow space adjustments between the lines.
Activity 3.15: Working with line spacing

1. **Select** the text you want to format.
2. Click the **Line spacing** command in the Paragraph group on the Home tab.
3. Select a spacing option.

If you select **Line Spacing Options**, the Paragraph dialog box appears.

1. Use the **Line spacing** drop-down menu to select a spacing option.
2. Modify the **before and after** points to adjust line spacing as needed.
3. Click **OK**.

**Working with Objects**

In the previous activities, you have been working with text only. In this section, you will add information to your text in form of objects. You will learn how to add images/pictures, tables, charts, smart arts, screenshots and illustrations.

**Making use of Clip Art Objects**

You might be asking yourself “what is clip art?” Clip art is a collection of pictures or images that can be imported into a document or another program. They are already part of your word processing software.
Activity 4.14: Working with Clip Art

1. Select the Insert tab.
2. Click the Clip Art command in the Illustrations group.
3. The clip art options appear in the task pane on the right.
4. Enter keywords in the Search for: fields that are related to the image you want to insert.
5. Click the drop-down arrow next to the Search in field.
6. Select Everywhere to ensure Word searches your computer and its online resources for an image that meets your criteria.
7. Click the drop-down arrow in the Results should be field.
8. Deselect any media types you do not want to see. In this case we only wanted Clip Arts.
9. Click Go to see a list of images depending on your search.
10. Try to insert other object types (tables, pictures, charts, header/footer).

Formatting Images/Pictures

Most times, images inserted may need some adjustments to fit properly into spaces where they are inserted. This can be done in various ways including cropping and compressing the images. When you crop an image, part of it is removed. Cropping may be helpful when a picture has a lot of content and you want to focus on only a part of it.

Activity 4.15: Cropping images

In groups, guide learners through this activity by way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

1. Select the image you want to crop. The Format tab appears.
2. On the **Format** tab, click the **Crop** command.

3. **Cropping handles** will appear around the image. Click, hold, and drag a **handle** to crop the image.

4. Click the **Crop** command to deselect the crop tool.

**Note:** The mouse pointer appearance may vary from MS Word version to version.

**Compressing images**

If you use large pictures in a document, its file size increases rapidly. As a result it may be difficult to share such a file via the Internet. You can reduce this problem by telling a word processor to compress the pictures inserted in a document.

**Activity 4.16: Compressing images**

In groups, guide learners through this activity by way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

1. Select the picture.

2. Select the **Format** tab.
3. Click the **Compress Pictures** command in the Adjust group. A dialog box appears.
4. Click the **Options** button to access the **Compression Setting** dialog box.
5. Choose the target output.
6. Change any of the default picture settings you want.
7. Click **OK** in the Compression Settings dialog box.
8. Click **OK** in the Compress Pictures dialog box.

**Activity 4.17: Comparison of compressing and cropping**

In groups, guide learners through this activity by way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

In groups, distinguish between cropping and compression in relation to images in a document.

**Working with Tables in a Document**

A table is made up of rows and columns. Tables are mainly used to organize and present information. You can also use tables to align numbers and create interesting page layouts.

**Activity 4.18: Inserting a table**

In groups, guide learners through this activity by way of demonstration. Allow learners to demonstrate other methods which may not be specified in the Learner’s Book provided they achieve the desired results.

1. Click where you want to insert the table.
2. Click the **Insert** tab and click on the **[Table]** button - a table grid and other options appear:
3. Create a **3 x 3 Table**. Drag the mouse cursor over the cells and click the mouse button when the table is of the desired size (if you hold down the mouse button, the table is drawn when you release it).

**Tip:** You do not have to set up the number of rows required when you first create a table as Word will automatically add extra rows for you as you type.

4. To move out of the table, press **<Ctrl End>** or use the **<down arrow>** key several times – the Table Tools tabs disappear, showing that you are no longer in the table.

5. Press **<Enter>** for a blank line.

**Inserting a table by setting the Number of Rows and Columns**

1. Position the Insertion Point where the table is required.

2. Click on the **Table** button (on the Insert tab) and choose **Insert Table…** command.

3. The Insert Table dialog box appears - under **Table size**; enter the **Number of columns** and **Number of rows**: required (here, set up 4 columns and **2** rows).
3. Create a 3 x 3 Table. Drag the mouse cursor over the cells and click the mouse button when the table is of the desired size (if you hold down the mouse button, the table is drawn when you release it).

   Tip: You do not have to set up the number of rows required when you first create a table as Word will automatically add extra rows for you as you type.

4. To move out of the table, press <Ctrl End> or use the <down arrow> key several times – the Table Tools tabs disappear, showing that you are no longer in the table.

5. Press <Enter> for a blank line.

Inserting a table by setting the Number of Rows and Columns

1. Position the Insertion Point where the table is required.

2. Click on the [Table] button (on the Insert tab) and choose Insert Table… command.

3. The Insert Table dialog box appears - under Table size; enter the Number of columns and Number of rows: required (here, set up 4 columns and 2 rows).

   The next set of options down, Autofit behaviour, determines how the column widths are defined. By default, column widths are set so that the table fills the page horizontally with equally-sized columns (as you saw with the first table). If you require specific widths (of an equal size) change Fixed column width: from Auto to the desired size.

4. Here, change Autofit behavior to Autofit to contents.

5. Press <Enter> or [OK] and a very small skeleton table appears.

Activity of Integration: Word-processing a Letter

Your class is planning an end of year party scheduled to take place on 21st November this year, in the main hall, starting at 8:30am.

Task: Word process a letter inviting the head teacher and members of staff to the end of year party.
<table>
<thead>
<tr>
<th>Output</th>
<th>Basis of evaluation</th>
<th>Criteria 1 Relevance</th>
<th>Criteria 2 Accuracy</th>
<th>Criteria 3 Coherence</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Word-processed letter</td>
<td>Message</td>
<td>Score 3 if the learner communicates the relevant message with the following elements: purpose, time, date, venue, addressee (All 5 features)</td>
<td>Score 3 if the learner communicates the accuracy of the message with clear purpose, time, date, venue, addressee (All 5 features)</td>
<td>Score 3 if the learner ensures logical flow and clarity of ideas.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Score 2 if the learner communicates the relevant message with the following elements purpose, time, date, venue, addressee (3-4 features)</td>
<td>Score 2 if the learner communicates the accuracy of the message with clear purpose, time, date, venue, addressee (3-4 features)</td>
<td>Score 2 if the learner ensures limited logical flow of ideas, with some distortions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Score 1 if the learner communicates the relevant message with the following elements purpose, time, date, venue, addressee (1-2 features).</td>
<td>Score 1 if the learner communicates the accuracy of the message with clear purpose, time, date, venue, addressee (1-2 features).</td>
<td>Score 1 if the learner no logical flow of ideas, with a lot of distortions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output</td>
<td>Basis of evaluation</td>
<td>Criteria 1 Relevance</td>
<td>Criteria 2 Accuracy</td>
<td>Criteria 3 Coherence</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------</td>
<td>----------------------</td>
<td>---------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Use of ICTs</td>
<td>Score 3 if the learner uses at least 4 font features (E.g. Bold, Font, Underline, Superscript/Subscript, Uppercase/Lowercase)</td>
<td>Score 3 if the learner uses at least 4 font features appropriately (E.g. Bold, Font, Underline, Superscript/Subscript, Uppercase/Lowercase)</td>
<td>Score 3 if the learner consistently uses the same font features throughout the letter (Font size/type, Underline, Superscript/Subscript, Uppercase/Lowercase)</td>
<td>Score 2 if the learner uses 2-3 font features appropriately (e.g. Bold, Font, Underline, Superscript/Subscript, Uppercase/Lowercase)</td>
</tr>
<tr>
<td>Output</td>
<td>Basis of evaluation</td>
<td>Criteria 1 Relevance</td>
<td>Criteria 2 Accuracy</td>
<td>Criteria 3 Coherence</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------</td>
<td>----------------------</td>
<td>---------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Score 1 if the learner uses 1 font (e.g. Bold, Font, Underline, Superscript/Subscript, Uppercase/Lowercase)</td>
<td>Score 1 if the learner uses 1 font feature appropriately (e.g. Bold, Font, Underline, Superscript/Subscript, Uppercase/Lowercase)</td>
<td>Score 1 if the learner consistently uses few font features in the letter (Font size/type, Underline, Superscript/Subscript, Uppercase/Lowercase)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Score 3 if the learner uses at least 4 of the following: alignment, spacing, numbering/bulleted, colour themes, boarders, sorting, indenting</td>
<td>Score 3 if the learner applies correctly at least 4 of the following: alignment, spacing, numbering/bulleted, colour themes, boarders, sorting, indenting accurately</td>
<td>Score 3 if the learner uses at least 4 of the following in a logical manner: alignment, spacing, numbering/bulleted, colour themes, boarders, sorting, indenting.</td>
</tr>
<tr>
<td>Output</td>
<td>Basis of evaluation</td>
<td>Criteria 1 Relevance</td>
<td>Criteria 2 Accuracy</td>
<td>Criteria 3 Coherence</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------</td>
<td>----------------------</td>
<td>--------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Score 2 if the learner uses 2-3 of the following: alignment, spacing, numbering/bulleted, colour themes, boarders, sorting, indenting</td>
<td>Score 2 if the learner applies correctly 2-3 of the following: alignment, spacing, numbering/bulleted, colour themes, boarders, sorting, indenting accurately</td>
<td>Score 2 if the learner uses 2-3 of the following in a logical manner: alignment, spacing, numbering/bulleted, colour themes, boarders, sorting, indenting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Score 1 if the learner uses 1 of the following: alignment, spacing, numbering/bulleted, colour themes, boarders, sorting, indenting</td>
<td>Score 1 if the learner applies correctly 1 of the following: alignment, spacing, numbering/bulleted, colour themes, boarders, sorting, indenting accurately</td>
<td>Score 1 if the learner uses 1 of the following in a logical manner: alignment, spacing, numbering/bulleted, colour themes, boarders, sorting, indenting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Score 2 if the learner prints the right document.</td>
<td>Score 2 if the learner applies correctly the right document.</td>
<td>Score 2 if the learner prints the right document.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Score 1 if the learner prints a wrong document.</td>
<td>Score 1 if the learner applies correctly a wrong document.</td>
<td>Score 1 if the learner prints a wrong document.</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*2/3 of the score for each output are sufficient to conclude that a learner is competent.
Chapter Summary

Ensure that learners have learnt about:

- How to load word processing application software.
- Format a Word document (page orientation, margins, size, fonts, paragraphing, etc.).
- Insert objects in a word document (tables, images, shapes, header and footer).
- Print documents.
Chapter Summary

Ensure that learners have learnt about:

• How to load word processing application software.
• Format a Word document (page orientation, margins, size, fonts, paragraphing, etc.).
• Insert objects in a word document (tables, images, shapes, header and footer).
• Print documents.